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Abstract

KChart is an application for visualizing numerical data. It has many differ-
ent chart types available like bar graphs, line plots, pie charts, ring charts and
more.

KChart is a KOffice component and is very well integrated with KSpread to
allow visualization of spreadsheet data. But it is also possible to use KChart as
a standalone application or integrate it in other KOffice components.
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Chapter 1

Introduction

KChart is a tool for visualizing numerical data. It can be used as a standalone
application with a simple Data Editor. But as a KOffice component it offers
very flexible integration. KSpread uses the KChart component for charts and
diagrams. KSpread can be seen as a very powerful data provider for KChart
input.

But embedding is not limited to KSpread. A KChart chart can be embedded in
many of the KOffice components like KWord, KPresenter or Kivio.

To start with we will look at the user interface of KChart and how it can be
used as a standalone application. When we are familiar with KChart we will

investigate the charting capabilities it offers together with KSpread.
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Chapter 2

The User Interface

2.1 Main Application Interface

We will take a look at a simple example to get to know KChart. Along the way
we will also discuss the user interface at length so you will learn about many
details of the component.

When you start KChart as a standalone application you get the usual startup
dialog where you can choose between different templates or load existing chart
documents.

*" KChart

File Settings Help

) @

Charts

@RecentDocuments
Bar Chart
Bar Chart
Charts
Blank Worksheet e T Tl

[] Always use this template

An example of a bar chart.

Open Existing Document
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You can choose between various ways to startup KChart. On the left, you
can see three options: Recent Documents, Charts templates and Open Existing
Document.... The first option lets you choose between recently opened charts,
the second is for creating a new chart from various templates and the third is
for opening an existing chart with a file dialog.

For now we will start with the default template. Select Charts in the left area
and then select Bar Chart in the main template area. Normally this template
should already be selected after choosing Charts.

If you decide to always start KChart with a selected template as default you
can also check Always use this template.

Click the Use This Template button on the right, under the template preview.

| KChart & (X

File Edit Format Settings Help

L% lTj Lj Ed o= =] Lfl LS j’

Legend

COOEFEFEIE

B Aow 2
B Fow 3
O Fow 4

Column 1 Column 2 Column 3 Column 4

As you can see, there is already some example data present. KChart offers
the default toolbar for creating a new chart, saving, loading and printing the
chart. The second toolbar offers icons for editing the data, configuring the chart
or using a configuration wizard. You can also switch between different chart
types with the rest of the icons. Note that some of these chart types also have
subtypes.

The menu offers all standard entries, including shortcut and toolbar configu-
ration and page layout for printing.

Note that data editing is not available if you use KChart from within KSpread
because all data is provided by the spreadsheet. As a standalone application
the Data Editor is an important part of the application.
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2.2 Chart Wizard

The wizard is actually a very useful part of KChart for quickly setting up some
basic options like chart type and chart labelling in a few easy steps.

You can run the wizard at any time, it will always preserve your data and other
configuration. Also, you can change every single configuration you do with the
wizard later as well, without losing anything. In fact the wizard is just a way
to set some basic and important options in one go.

To start the wizard simply click on the icon in the toolbar.

2.21 Step 0 - Choosing the Data source

**' Kkchart
Data

—[Data Area
Area:[

| | Firstrow as label

| | Firstcolumn as lahel

—Data Format
(@ Datainrows

() Datain columns

Ifthe selected data area does not match the data you want,
selectthe data now.

Include cells that you want to use as row and column [ahels,
if yaou want them in the chart.

] [ Einish ] [ Cancel

The first step in the wizard is to actually choose the data source. If the selected
data area does not match the data you want, select the data now.
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Include cells that you want to use as row and column labels, if you want them
in the chart.

Then go to the next step with the Next > button. You can also choose Finish at
any step if you are already comfortable with the setup done so far.

2.2.2 Step 1- Choosing the Chart Type

Select Chart Type

Bars and Lines

) | |

Hi-Lo-Close Box & Whisker

© & o

Fig Ring Fuolar

< Back ] | ] [ Finish ] [ Cancel

The next step in the wizard is to actually choose the primary type of the chart.
This selection has the most important impact on how your data will be pre-
sented. Thus it should be chosen well. You can change the type of the chart
with the icons in the toolbar without losing any data or configuration later on.
In fact it is even considered normal to test all the various chart types to find the
best fitting.

In this example we choose the Lines type. Depending on the chosen chart type
different options are available in the following steps.
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After choosing the type you can get to the next step with the Next > button.

2.2.3 Step 2 - Choosing the Subtype

Select Chart Sub-type

—Chart Sub Type
(@ Mormal

() Stacked
() Percent

Mumber of lines: | a %

<Back | [Nexi="| | Finish | | Cancel

In case the chosen chart type has various sub types you can choose it in the
second step. If the chart type has no sub types, this step will be skipped auto-
matically.

If you decide to change the sub type later, you can do this in the appropriate
configuration dialog which will be shown later.

You can simply leave the default selection and go to the next step. Of course
you can chose any desired sub type if you want.
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2.2.4 Step 3 - Labels and Legend, Fonts

Labels & Legend
Title: [ || Font.. ||HEEEEEE
Htitle: [ || Font. ||
Yits: | || Font.. ||HEEEEEN
Legend title: [Legend || Font.. ||
Legend text: [ Font... H_]

In the third step you can set the text for the chart title, the axes and the legend.
You can also configure the desired font in detail for each of these.
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2.2.5 Step 4 - Axes

Setup Axes

| Has grid:

Angle 30: |
Depth 30: |

]
—

|

1

.............................

[ < Back l [ Finish [ Cancel ]

The last step of the wizard lets you set various options for the axes and other
options, depending on the chart type.

You can either choose Finish to accept the options for your chart, go < Back
and change various things or simply dismiss all options from the wizard by
choosing Cancel.

If you choose Finish all your choices in the wizard will be integrated in the
chart and you can continue to enter some data and do some fine tuning of
various options.

Remember that the chart configuration dialog has many more options avail-
able, we will discuss these later.

2.3 The Data Editor

The Data Editor can be reached by selecting Edit — Edit Data... from the menu
or by clicking on the icon in the toolbar.
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' KChart Data Editor - KChart 2 O
| Column 1 | Column 2 | Column 3 | Column 4 |
Row 1 0 1 2 3
1 2 3 4
3 4 5 5

#Rows:# Columns:

[ oK H Apply H Cancel l

The Data Editor can be used to set all values. You can also define the number
of rows and columns.

Depending on the chart type rows and columns have different representations.
Each row can generally be considered to be one data series or data set while
each column represents the values of all data sets at a certain location.

The name of a data set can be changed by clicking on the row header (left of the
first column with values). The name of a column can be changed by clicking
on the column header (above the first row).

The number of rows and columns can be adjusted to fit the needs. Since version
1.4 the restriction to 16 rows and 16 columns has been eliminated.

2.4 Chart Configuration

KChart offers many configuration options for the chart. These are available in
standalone mode and when embedded in KSpread

Depending on the chart type you have selected, the available options are slightly
different. Let’s choose the line chart type by clicking on the icon in the toolbar.

To get to the chart configuration dialog, select Format — Chart... from the
menu or click on the icon in the toolbar. You might need to click on the
right or left arrow at the top of the dialog to get all pages if the width of the
dialog is too small.
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241 Row and Column Swapping

! Chart Setup 70X

l Chart Sub-type |I=ine |ﬂeader.fFooter | Legend | Axes |go|ors |£ont L] B

—Data Area
Area:[ ]

[ ] First row as label

[ ] First column as label

~Data Format
(@ Data in rows

() Datain columns

[ Ok ” Apply H Cancel ]

The first configuration page can be used to swap the interpretation of rows and
columns. By default one row is considered to be a data set and each column
holds the individual values of the data series. Here you can choose to have a
each column hold one data set. Note that the values are not really swapped
but only their interpretation.

10
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2.4.2 Chart Subtype

#% Chart Config Dialog 2 O %

—Subtype
® Mormal

() Stacked
() Percent

—Example

[ oKk || Apely || cancel |

The second page can be used to select the desired sub type of a chart. The
available sub types depend on the chart type, in this case the line chart. Some
chart types have no sub type at all in which case this configuration page is not
shown. You also get a preview for each subtype.

Remember that the chart type can be chosen from the toolbar while the subtype
can be set through this configuration dialog.

11
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2.4.3 Header and Footer

#% Chart Config Dialog 2 O %

[Qata | Chart Subtype | Line ‘ﬂeaden’Fouter I Legend | Axes | Colors | EOHEB

—Header/Footer
Title: [ l [_l [ Font... l
Subtitle: [ l [_l [ Font... l
Footer; [ l [_l [ Font... l

[ OK H Apply H Cancel

On the third page you can set the title, the subtitle and the footer of the chart,
each with individual font settings.

12
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244 Legend

% Chart Config Dialog 2 O %

—General —Fant
Title: Legend title font:
Legend l [ Select Font... l
Legend text font:
[ Select Font. .. l
—Legend Position —Colar
EII‘ hﬁl Legend title color:
L 1

Legend text color:

b, || ——

=]
E
o E | Ee
E
=]

[ ok || Apely || cancel |

The legend configuration page lets you set all aspects of the legend. The legend
contains the names for all data sets with the respective colors, this is important
to identify the data on the chart.

The General box holds the title of the legend, which is displayed at the top of
the legend box. The Position box can be used to place the legend at various
locations on the chart. Use the central button to hide the legend.

The Font box can be used to set different fonts for the legend title and the
individual entries. Additionally you can set different colors in the Color box.

13
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2.4.5 Axes

[Qata | Chart Subtype | Line | Header/Footer | Legend J&xes Colors | Fon 4 |:

—Parameters ~Settings
[ Grid H-title: Y-title:
[%] Y-axis [ ] l
—acale Types
(€] X-axis .

@ Linear scale

() Logarithmic scale

—Precision for Numerical Left Axis
(@ Automatic precision

() Decimal precision:

[ =

[ oK || Apply |[ Cancel |

The Axes page holds configuration for the chart axes. This page highly de-
pends on the chart type chosen. For the line chart you can set linear or loga-
rithmic scales and turn the grid on and off.

14
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2.4.6 Colors

#: Chart Config Dialog 2 O %

[Data | Chart Subtype | Line | Header/Footer | Legend | Axes I Colors! | Fonl4 |:

—Colors
Line color: E}
Grid color: E} EE:;
¥-title color: E} Row 4
Y-title calor: E}
X-label color: E} :
Y-label color: E} |

[ OK H Apply H Cancel

On the Colors page you can choose the colors for the individual data sets. You
can also set colors for some general chart parts like axes Line color and Grid
color.
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2.4.7 Font

% Chart Config Dialog 2 O %

ita |Char1 Subtype |Line |ﬂeaden’Footer |L§gend |ﬁxes |§o|ors I IEB

[ K H Apply H Cancel

The Font page can be used to configure various fonts like titles, axes labels and
so on. Some of these fonts can be set on other pages as well, but on the font
page you have them all in one place.

16
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2.4.8 Background

#% Chart Config Dialog 2 O %

itype | Line | Header/Faoter | Legend | Axes | Colars | Eont IBaCEground »
—Wallpaper Configuration
Background colaor: Intensity in %:
(@ Stretched
[| ] () Scaled
() Centered
Background wallpaper:
[Nune |v]
[ Browse... ]
[ QK l [ Apply H Cancel ]

On the Background page you will find various options for tweaking the back-
ground settings of the chart. You can either choose different background colors
or even a background picture.

2.4.9 More...

This short overview of the configuration options gave you an introduction to
the configuration possibilities of your chart, it is by no means complete. Differ-
ent chart types like Bar, Line and Pie, have additional specialised configuration
pages and you are welcome to look around, try different chart types and look
at the configuration possibilities. Use the tooltips and read the What’s This?
help. To use the What’s This? help simply click on the question mark on the
window decoration and then click on the area of the configuration page you
want get more information on.

17
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Chapter 3

KChart as a standalone
Application

The previous chapter described the user interface, various configuration op-
tions, data editing and the wizard in detail.

This chapter gives real-life examples on how to use KChart in various situ-
ations as a standalone application. The purpose is to give you some under-
standing of the way KChart works and how various parts relate to each other.

3.1 Presenting Sales Figures

3.1.1 Warming up

This first example which might often be encountered in real life is presenting
sales figures, or in this particular case profit.

Imagine you own a company that has three main categories of business: sales,
support and training. And you would like to present the profit of these cate-
gories over some years. Making a graphical statistics is certainly a good idea.
KChart can help you here.

3.1.2 Getting started

Run KChart and select the Blank Worksheet.

18
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' KChart = B X%
Eile  Seftings  Help

Charts
@Recent Documents
hl Bar Chart

B Charts

Elank Worksheet

Blank Worksheet

Use This Template

[] Always use this template

Open Existing Document...

Hit the button Use This Template to get started. KChart will present to you a
completely empty document. That’s good, we just need to enter some data and
do some basic configuration to get a nice chart.

19
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*" KChart _ O x
File Edit Format Settings Help

4 B e s t% P

SOOEEFFITE

3.1.3 Getting the numbers in

The first step, and probably the most important, is to get the actual data into
the chart. This can easily be done with the Data Editor. As usual you can get
to the data editor by clicking on the icon in the toolbar.

You will notice that no data is present. Also note that the number of data rows
and columns is set to a minimum, which is 1.

Now, just enter the data you see in the next screenshot. Note that you can
increase the number of rows and columns with the spin boxes in the lower left
corner. The names of the rows and columns themselves can be changed by
clicking on them.

20
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*: KChart Data Editor - KChart

2003 2004 2005
| 50 45 42
70 85 115
30 50 90

|Cha|1 data, each row is a data set. Headers can be changed by clicking on them.|

#Rows:# Columns:

[ 0K H Apply H Cancel l

Simply click the OK button when you are done. This will present to you a
simple bar chart.

*: home/annmafrial.chrt [modified] - KChart

File Edit Format Settings Help
fEEd = 4SS

[:::] 110

B [T

Legend

B Series1
O Saisz
B Series3

0@~

2003 2004 2005

Read on to do some fine tuning!

21
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3.1.4 Fine Tuning
We will now do some fine tuning and put a title on the chart. And, we will add

a nice 3D effect to the bars as well.
Start up the configuration dialog by clicking on the icon in the toolbar.

3.14.1 Title

% Chart Config Dialog

[Qata | Chart Subtype | Bar Iﬂeaden‘Footer Legend | Axes | Colors | Fant 4 B

—Header/Footer

Tile:  [Profi || - Font... |
Subtitls: [From 2003 to 2005 | [N | Font... |
Footer; ||[|:] Best Business ”_H Font... l

[ K ” Apply H Cancel

Let’s start with labeling. Go to the Header/Footer page and enter the text like
in the above screenshot.

3.1.4.2 X-Axis Font Settings

The next step is to make the font of the x axis a bit bigger. You can do this on
the Font page.

22



The KChart Handbook

** Chart Config Dialog 7 O x

ata |Char1 Subtype |Ba[ |ﬂeaden’Footer |I:egend |ﬁxes |§o|ors IEont IEE]

[ OK | Apply || Cancel |

Choose the X-Axis item and click on the Font... button. Choose a somewhat
larger font like in the following screenshot.

23
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i Select Font - KChart 2 0%

~Requested Font

Font: Font style: Size:
ESSTIHTwelve B [ 34 l%]
ESSTIXTwa ltalic

Ekushey Azad Bald 12 B
Ekushey Punarbhaba Bold ltalic 14

Estrangelo Edessa 7

Fixed [Misc] 18

Fixed [Sony] 20

Franklin Gathic Medium 24

Gautami 25

Georgia

I E— X Relsv

The Quick Brown Fox Ju

[ Dk H Cancel l

Note that the font size is set to Relative. This means that the font is automati-
cally scaled according to the overall chart size. This is quite useful and most of

the time what the average user expects.

3.1.4.3 Giving it a 3D Look

Some types of charts like Bar and Pie have an additional configuration page.

24
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1. Chart Config Dialog ? O x

ata |Char1 Subtype JBa[ Iﬂeaden’Footer |I:egend |ﬁxes |§o|ors |Eont BI]

—3D Parameters
@\E]rag ;-ark shadow
Angle: s A
Depth: ,,,,,Q,,,,, 1-00
[ 0K || Apply || Cancel |

To get a 3D effect for this type of chart, go to the Bar page and simply activate
3D bar.

That’s all what we need for a reasonable looking chart. Note that much of this
configuration could also have been achieved with the wizard. It’s basically a
matter of taste what you use. Experienced users will likely use the full option
dialog we used in this example.

Simply accept the settings by clicking on the OK button.

3.1.5 Final output

The final chart will look like the next screenshot.

25



The KChart Handbook

#{ home/annmalrial.chrt [modified] - KChart

File Edit Format Settings Help
L= R N7 EN R N
Profit

From 2003 to 2005

¥

110

Legend
B Saisi
O Seriesz
B Series3

0@~

2003 2004 2005

ic) Best Business

You might want to enlarge the application window to see the chart in full size.
Note how the fonts get larger in relation to the chart size.

There are certainly aspects to improve further for your personal taste. For ex-
ample try to make the title font even bigger. Just experiment further, this way
you will get to know a lot of the KChart application.

Finally you can save the chart from the File menu and quit KChart with File
— Quit

3.1.6 Exporting to Graphic Formats: SVG, PNG, JPG, Krita,
Karbon14, Gimp and more

For further processing, the chart can also be exported as a graphics file. Many
formats are available. Using either PNG, SVG, JPG or Krita will likely produce
the best result.

To export your current chart simply choose File — Export... from the menu and
select the desired file format from the filter box.

26
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Chapter 4

Using KChart in KSpread

In addition to standalone operation, KChart is designed to be used with KSpread.
This chapter describes how to create and manipulate charts from within KSpread.

Remember that KChart embedding into KSpread is a very commonly used and
well implemented feature, the examples in this chapter should just get you
started.

As soon as you have created a chart in KSpread you can take full advantage of
all the KChart features by double clicking on the chart area. This is necessary
to get to all advanced configuration options. Keep in mind that the data editor
is not available when KChart is embedded into KSpread. This is obvious since
KSpread serves, from KChart’s point of view, as a powerful data provider.

Swapping x and y is of particular interest when working with KSpread. You
can swap interpretation of x and y axis in KChart in the Data Format settings
which can be accessed through the Edit menu or the context menu when right
clicking on the chart itself. As noted above you need to be inside the KChart
component in order to access these settings, which can be done by double click-
ing the embedded chart in your spreadsheet.

4.1 Plotting with KChart

To plot with KChart, when it is embedded in KSpread, do the following:

27
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A B C D E F G H | J
2 3 4 5 ] 7 8 9 10
1.41421 173205 2 223607 244949 264575 2.82843 3 316228
[ A [ |5 b [ A [ |5

-

m
-

r

w

Sojuare Roots

=

[+)]
1

=]
@
|

=1

=]
|

w

B Series 1

16

e Highlight the second row of numbers.

e Next click on the Chart button to create the chart.

e Select the options you want from the chart wizard. The chart Wizard will
pop up after you insert the chart.

The whole data could also be created using two columns instead of two rows.
If using columns you might want to switch x and y axis in the KChart configu-
ration as described above.

To make a bar chart for individual items, put the numbers in a column, as
shown below.

A | 8 | ¢ | o | e | F | & | H |
1 15
2 2 Ear Plot
130
3 35 120
P 42 110
100
5 51 1
B
= B Series 1
B Series 2
8 B Series 3
9 O Series 4
B Seties 5
10
11
12
13 Hem 1
14
18

The orientation of the numbers determines how the plot will be made.

28



The KChart Handbook

e A row of numbers defines the ordinates for a single plot.

e A column of numbers defines the heights for each bar, in a bar graph. It also
determines the size of the slices in a pie chart.

29
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Chapter 5

Command Reference

5.1 The Main KChart Window

5.1.1 The File Menu

File — New (Ctrl+N) Creates a new document

File — Open... (Ctrl+O) Opens a document
File — Open Recent Shows a list of recently opened documents

File — Save (Ctrl+S) Saves the chart to the current file. If the chart has not yet
been saved the file dialog is shown.

File — Save As... Saves the document, the file dialog is used.

File — Reload Reloads the document.

File — Import... Opens a document with any supported format. The original
document will not be modified.

File — Export... Saves a document to any supported format. The original doc-
ument will not be modified. You can also choose among many image
formats like PNG, SVG, Krita, Gimp or JPG.

File — Mail... Sends the chart as an email attachment.

File — Import Data... Imports values from a CSV (Comma Separated Values)
file, much like the CSV import in KSpread. Note that you can specify
various options and different separators (not just commas).

File — Create Template From Document... Create a KChart template based on
this document.

File — Print... (Ctrl+P) Prints the document

30
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IMPORTANT
Make sure the proper print system is selected in the Print system currently
used: section. This option can be seen after clicking on the Options » button.

File — Print Preview... Displays a preview of what the printed document will
look like.

File — Document Information Opens a dialog box where you can enter infor-
mation about your chart.

NOTE

This document information will be displayed in the Konqueror file browser as
a tooltip. The tooltips are pop-ups that show the contents of a file when you
move your mouse over the file icon.

File — Close (Ctrl+W) Closes the current chart.
File — Quit (Ctrl+Q) Quits KChart

5.1.2 The Edit Menu

Edit — Edit Data... Opens the Data Editor.

5.1.3 The Format Menu

Format — Chart... Opens the KChart Configuration dialog.

5.1.3.1 The Configure Tabs

Data Format... Swap row and columns (x/y flipping).
Chart Sub-type... Changes the arrangement of bar graphs.
Header & Footer... Enter the titles you want for your graph here.

Colors... Select graph colors, line colors, grid colors and axis title and axis label
colors here.

Font... Select font style and size here. The series colors can be selected here
also. The series refer to the individual graphs. Each graphed set of data
is a series.

Background... Select a color or a wallpaper as background for your graph.

Legend... Change title, font and location of the legend box. The color of the
legend box can be changed also.

Page Layout... Set the Margins of the page here.
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5.1.4 The Settings Menu

Settings — Toolbars Show/Hide various toolbars (File, Actions and Types).
Settings — Configure Shortcuts... Configure key shortcuts for KChart.
Settings — Configure Toolbars... Configure the KChart toolbars.

5.1.5 The Help Menu

Help — KChart Handbook (F1) Invokes the KDE Help system starting at the
KChart help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KChart will open a
help window (if one exists for the particular item) explaining the item’s
function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — Switch Application Language... Opens a dialog where you can edit
the Primary language and Fallback language for this application.

Help — About KChart This will display version and author information.

Help — About KDE This displays the KDE version and other basic informa-
tion.

5.1.6 Configuring Shortcuts

The Settings — Configure Shortcuts... allows you to specify shortcuts.

Below is an example of how to configure a shortcut for opening the chart wiz-
ard.
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*i| Configure Shorteuts - KChart

Search: [

Action *f: Configure Shortcut - KChart
KChart

I8 Area (® Primary shortcut:

Background. ..
HBagr () Alternate shortcut:  E3 D

|e® Box & Whiskers [ ] Multi-key mode
=4, Chart....

Colors...

Create Template From Document...
* Customize with Wizard. .. Alt+Ctrl+WW

Data Format. ..
/| Edit Data...
Font...

Header and Footer...
I Hil n

—Shaortcut for Selected Action

) Mone () ® Custom Al+CHr -+

Default key: None

oK Cancel

KDy

e Click on Custom.

o Next click on Primary shortcut:.

e Do Alt Ctrl W and the dialog should disappear. The shortcut is now en-
tered.

Pressing the keys A1t Ctrl Wnow opens the wizard.
5.1.7 Configuring Toolbars

The Settings — Configure Toolbars... is used to add additional buttons to the
toolbars.
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*i Configure Toolbars - KChart

Toolbar:
| File <KOffice> |
Ayailable actions: Current actions:
Import... [« ) Mew
WA KChart Handbook [ Open...
o Mail... o Sawe
4 Cpen Recent ] Save As...

b Prin.
Reload = Print Preview...

] Remave Yiew
Report Bug...
Show Actions (KChart) Tool
Show File (KChart) Toolbar
Show Types (KChart) Toolha

ki Splitter Orientation

FH Split View

[4_| | [I|I] [ Change lcon... ]

(o) [ G

(4}

To add a button to the File toolbar,

[ Fr B o 0

make sure File <KOffice> is displayed in the top combo box.

Click on one of the items in the left hand pane. This item will now be high-
lighted showing that it has been selected.

Next click on the Right arrow button to place it in the right pane.

e Click on Apply and then click on 0K

) @ = ) [0

The new Item should be in the toolbar.
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Chapter 6

Credits and License

KChart
Program copyright 1998-2005 the KChart Team

Original Authors:

e Matthias Kalle Dalheimer kalle@kde.org
e Torben Weis weis@kde.org

Contributors:

e Laurent Montel Imontel@mandrakesoft.com

¢ Karl-Heinz Zimmer khz@kde.org
e Inge Wallin inge@lysator.liu.se

Documentation copyright 2002 Jonathan Drews j.e.drews@att.net
Documentation copyright 2005 Raphael Langerhorst raphael.langerhorst@kdemail.net

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.
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